The Church Executive™ — Introduction
The Church Executive™ is an all-encompassing database that meets the needs of any church, no
matter how large or small or which denomination.

Introduction

The database consists of several modules:
Index
Introduction . . . . . . . . .
New features . . . . . . . . .
Terminology . . . . . . . . .
Generic Access . . . . . . .
Navigation . . . . . . . . . .
Mouse vs keyboard . . . .
Find . . . . . . . . . . . . . . . .
Field movement . . . . . .

1
1
2
3
4
5
5
5

Watch out for...
Find (Ctrl-F) . . . . . .
Editing text . . . . . . .
Pull-down menus . .
Dates . . . . . . . . . . .
Where am I? . . . . .

6
6
7
7
8

<
<
<
<
<
<
<
<
<
<

Family demographics
Personal details
Classes
Pastor records
Ministry
Chorus/Hymns
Envelopes
Stewardship
Weekly services
Weekly contributions

<
<
<
<
<
<
<
<

Accounting
Events
Facilities
Library
Signage
Property
coded Look-Up tables
System and User configuration
(including security)

Backup . . . . . . . . . . . . . 9
Using other computers

10

New features

These are features that are
new to the Windows
version of The Church
Executive™ that were not in
the DOS version.

The Church Executive™

Access allows us to incorporate new and exciting features that were either not implemented or
available in DOS version of The Church Executive™. Here is a sample:
<
<
<
<
<
<

e-mail button on respective screens. Takes e-mail address and loads Outlook automatically.
incorporate images, such as family, person, and church signage.
move between various modules with far greater ease.
multiple forms (modules) open at the same time.
reporting: multiple criteria options available; print preview; reports can have images.
cut and paste between any other Windows application.

<

new modules for: Classes, Chorus/Hymns, Accounting, Events, Facility usage, Library,
Signage.
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Terminology

Database

the complete set of tables, forms, queries, reports, programming code.

Table

an individual set of information, such as a Family list or a Envelope list.

Fields

individual pieces of information for each table, such as Phone number, envelope
number, etc.
Certain fields at certain times may be disabled — they cannot be
modified based on the current conditions. You must wait until the field
is enabled before the cursor can be placed in the field.
Fields that are “flat” and without any border are either
look-up fields from another table or calculated fields
(this is by design). Sunken fields can be edited.

Data types
We are aware of the most common data types for fields: Text, Numeric, String, etc.
Access has a data type called null. This is when the field contains nothing, not even a space.
A field that contains even a space (by hitting the space bar) contains something and is no
longer null. When doing queries, it is quite common to query on IsNull, that is, only find
those records where this field contains nothing.
Edit/Saved records
As soon as you begin typing in a
field in a record, that record is
locked and editing begins. The
icon in the left hand bar (called
the record selector) on the form
changes from a black triangle to a
pencil. As long as the pencil icon
is present, the data for this record
has not been saved — moving to
another record, opening another
form, or clicking the Save button
on the form will save the data.
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Figure 3
Saved record

Figure 4
Edited record

Figure 5
Locked record
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‘Generic’ Access
You may me using The
Church Executive™ via the
Microsoft Access program
(version 2000, 2002, or
2003). If so, this page may
be of interest.

Access is an extremely powerful program. To take advantage of its capabilities, we have developed
custom input forms, many of which are based on queries. The custom designed reports are based
on selection criteria input forms and queries.
However, there will rare occasions when we will need to
work with the raw data. This will involve working with the
various underlying Access objects — tables, queries, reports,
and forms.
Use the Window pull-down menu to gain access to this raw
data. The first menu option, ce : Database, gets us to the
Access objects screen.
The Access Objects are
grouped into common
categories:
< Tables
< Queries
< Forms
< Reports
< etc.
Clicking on the object
name at the left will
display those respective
objects.

Caution:
Do not design and change any of the existing tables, forms, queries,
reports, etc. as they are essential to the proper working of the program.

Adminware takes no responsibility for any changes you make that
renders the program non-functional!

The Church Executive™
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Navigation

As with any Windows program, there is usually more than one way to accomplish a given task.
Moving throughout The Church Executive™ is no different.
Following are various methods of moving from one module to another:
<

via the Main Switchboard. This is the form (screen) that appears first when the program
is loaded. There are buttons available to each of the various main modules. From within
a given module there will be other buttons to move you to sub-modules.

<

use the Window pull-down menu. The Window
pull-down menu (Alt-W) will list all of the
currently open modules. Pressing the number of
the desired module will move yo to that module.
If the module you want is not yet open, choose 2
Switchboard and then select the button.

<

the Toolbar has icons to open/move you to the
desired module:

Figure 10
Switchboard People
Ministry
Services
Library
Family
Pastor
Envelopes Contributions LookUp

<

double-click on a family unit number, person number, envelope number, vendor number,
accounting transaction, etc. from any module will move you to that module and display the
corresponding record.

Figure 11 Main Switchboard
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Mouse vs Keyboard

Most people use the mouse in Windows applications to move around the screen and to choose
commands — that is the nature of a graphical-based interface. However, a database program is a
data-oriented application where the keyboard is used extensively to add and edit information. Much
effort has been made to provide keystroke options as often as possible.
In any Windows application, an underlined letter
indicates that a keystroke (Alt-letter) will invoke
that option/command.
In the illustration to the right, pressing Alt-I will
invoke the Insert pull-down menu; but Alt-U will
place the cursor in the Unit # field! — why take your
hand off the keyboard, find the mouse, move the Figure 12 Alt-letter selecting
mouse so the insertion point is in the Unit number
field, click the left mouse button, put your hand back on the keyboard, and continue working?
With that said, there are many instances where the mouse is more efficient than using the keyboard.

Find

Finding a specific record is an important part of working with, and editing, your data. There are a
number of options available to move through the records in a table.
<

use a Quick Find option to find one (or more) matching record(s).

<

use a ‘Jump’ option to pop-up a matching list of records.

<

move one record at a time, either forward or backward. This will only be of benefit if the
data in the table is in a logical order pertaining to the type of editing you are doing. There
are two places on the form that you can move this way:
<
<

via the Toolbar
via the record selector at the bottom of the form

Figure 14
Record selector (bottom of form)

<

Field movement
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Figure 13
Toolbar record
selector
[First Previous Next
Last AddRecord]

use Access’ Find feature (Ctrl-F) from most fields. This will search the current field for the
desired information, displaying one entry at a time. You cannot use this feature in subforms
or in datasheet views as there is very limited information in these lists.

When moving through fields on a form, either adding a new entry or editing the existing entry, use
the Tab key to move to the next field and Shift-Tab to move back to the previous field.
Key

Movement

Tab

next field

Shift-Tab

previous field
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Watch out for...
Find (Ctrl-F)

Here are some known features and/or bugs that one should be aware of...

Access’ Find (Ctrl-F) command, like the Find feature in Microsoft’s other products, is really called
Find next. The key word here is next.
Access begins its find (search) starting with the next record, not the current record.
Consider the following:
<
<
<
<

you are sitting in the family screen in the unit number field on unit# 1000.
you do a Find (Ctrl-F)
you search for unit number 1000.
you will receive the following message:

This message is suggesting that Unit # 1000 does not exist in the family table (even though it
does!). However, based on the Access Find next feature, Unit# 1000 does not exist after the
current record (and it wouldn’t because each Unit number is unique).

Editing text

Be cautious of selected text.
Text is selected when it is highlighted (ie. white on a
black background). Just like in any Windows
application (such as Word), if text is selected and you
begin typing, the entire selected text will be replaced with the new text. Be cautious of this but also, use it
to your advantage!
If you want to delete a lot of text, select it and then press the delete key! Done.

The Church Executive™
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Pull-down menus

It has been mentioned before that using the keyboard can be quicker than the mouse in many
instances. If you get in the habit of using the keyboard to select fields, buttons, and pull-down menu
options, you may fall into the following problem...
If you press the Alt key, change your mind, and do not select any other key, you have actually
activated the pull-down menu!
Here is the generic Access pull-down menu:

Here it is again when the Alt key is pressed once and then released:

Notice the File menu option — it has been selected, as indicated by the raising of the word!
If you now press a letter associated with one of the pull-down menus (say T), you will pull-down
that menu option — even though you might be expecting the T to be typed into the current field
you are editing.
To de-activate the pull-down menu you can:
<

press the Esc once (if you have a menu pulled-down you will need to press Esc twice —
once to get rid of the menu and a second time to leave the pull-down menus altogether).

<

click the mouse somewhere on the screen.

Or

Dates

Date fields in the program are displayed as dd-mmm-yy.
When entering dates, you can simply enter ‘Jun 19’. Access will automatically convert this to
19-Jun-02 (or whatever the current year is).

The Church Executive™

<

A two-digit year is converted to four digits, where less than 30 becomes 20nn and greater
than 29 becomes 19nn.

<

To enter today’s date, press Ctrl-;
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Where am I?

Take at a look at the following image. Where is the cursor?

Answer: notice the Family Members tab (right side, down about an inch) — there is a dotted border
around the tab control.
There are many fields, menus, buttons, tabs, sub-forms, lists, etc. found on any one form in The
Church Executive™. When you press the Tab key to move from one field to the next you may also
need to pass ‘over’ a tabbed control or button. As you do so, it may appear as though you have lost
the cursor.
Here are some examples of what the cursor may look like as you move about the screen:

End of field (blinking)

Tip:

The Church Executive™

Datasheet with entire
field selected

Button (dotted border
around text)

Tabbed control (dotted
border around text)

Pull-down menu
activated

In many cases, don’t worry about where you are, but rather where you would like to be. Simply click the
mouse where you want to go or select a button or field by pressing the Alt-letter option.
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By far the most important function which needs to be managed with any computer system is the
backup of data.

Backup

All of the information that you have entered into The Church Executive™ is stored in ONE database
file: ce_be.mdb
Stand-alone
On a typical stand-alone system this file will be in the c:\ce folder.
Network
If you are running on a network then this file may be in a f:\ce folder (or some other drive or folder
designation — where ever it was placed as part of the installation of the program by yourself or a
network administrator).
[The above c:\ce and f:\ce are the most typical location for the ce_be.mdb file. There is a possibility
that the program and/or data was placed into different folders at the time the program was
installed.]
File Size
The ce_be.mdb will be too large to fit onto a single floppy disk. You will need to either use a Zip disk
(such as the Iomega line of products), a large capacity Memory (or flash) key, or a writable CD or
‘better’ (such as a re-writable CD or DVD).
Hazards

Some of the hazards to be aware of, which could cause information to be lost or destroyed, include:
<
<
<
<
<
<
<
<
<
<
<
<

static electricity
power surge
magnetic interference
faulty hardware (computer or hard disk)
faulty network cards, cabling, or routers
cigarette smoke
coffee or food spills
theft
vandalism
fire
out-of-date version of Microsoft Access
tampering with data

A few of these problems can ‘creep up’ on your system such as a faulty disk drive. Others are
beyond the control of a church, such as fire.

The Church Executive™
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Daily Backup

Having a regular system in place for backing up your daily, preferably on a daily basis, is essential.
We strongly recommend that you have a different backup disk (either Zip or CD) for each day of the
week, plus a weekly set.
Each backup media would be labelled as following:
<
<
<
<
<
<

Monday
Tuesday
Wednesday
Thursday
Friday
Weekly

Of course, if you are entering or modifying lots of data on Saturdays, then an additional disk should
be available.
In this scenario you would only use the Monday disk on a Monday – never on any other day of the
week.
If you already have a backup routine in place for backing up your other important files (such as
word processing documents, spreadsheets, or accounting information), then you will want to add
the ce_be.mdb file to this routine.

Using other standalone computer(s)

If you are using two (or more) computers as stand-along systems (not networked) to work with The
Church Executive™ data, you will need to transfer information from the ‘master’ computer to the
‘other’ computers.
The general procedure is as follows:
â only add and update data on one computer (the ‘master’
computer).
ã backup the ce_be.mdb file from the master computer.
ä walk (or run or drive!) to the other computer. This ‘other’
computer could be in the church or at your home.
å restore the backup (ce_be.mdb) to the other computer.

Be aware that you will be
providing the other
computer with ALL of your
church’s data that is stored
in The Church Executive™,
including names, address,
phone numbers, donations,
accounting, pastor records,
etc., etc.

[It goes without saying that the ‘other’
computer will need to have The Church
Executive™ program installed on it.]
æ the other computer now contains updated data ... until information is added or changed on the
‘master’ computer.
Almost NEVER transfer a backup from an ‘other’ computer to the ‘master’ computer.
When you receive a program update, don’t forget to update all of the ‘other’ computers that are
running The Church Executive™.
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